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About IBM Marketing Platform version 9.1.0

This section describes the new features and changes introduced in the 9.1.0 version
of Marketing Platform, and where to find information about changes in support for
third-party software in version 9.1.0.

System requirements and compatibility
This section provides information on where to find system requirement and
compatibility information for this release of IBM® Marketing Platform, and
highlights changes in support for third-party software.

Where to find complete system requirement and compatibility
information

For a list of IBM EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).

Note: To access the IBM EMM documentation from the Support Portal, you must
log in with an IBM account. This account must be linked to your IBM customer
number. To learn more about associating your account with your IBM customer
number, see Support Resources > Entitled Software Support on the Support
Portal.

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

New features and changes in version 9.1.0
This section describes the new features and changes introduced in the 9.1.0 version
of Marketing Platform. For complete details on new features, see the IBM
Marketing Platform 9.1.0 Administrator's Guide.

The IBM EMM Scheduler has been enhanced

The following enhancements are added for the IBM EMM Scheduler.
v Scheduler management pages now display additional information.

On the Schedule Definitions page, you can find scheduled items and use links to
navigate to them.
A new column on the Schedule Definitions page lists the last two runs and the
next run of recurring schedules. (ENH18928, ENH18914)
Additional details about individual runs have been added on the Scheduled
Runs page, and you can also cancel selected runs on this page.

v A new configuration property, Platform | Scheduler | Enable Scheduler, allows
you to disable the scheduler if your organization does not use it.
Disabling the scheduler frees additional system resources and can improve
performance.
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v A new configuration property, Platform | Scheduler | Maximum Unknown
Status Polling Count allows you to specify the number of times the scheduler
checks the status of a scheduled run for which the status cannot be determined.
After this limit is reached, the run status is listed as Unknown on the Settings >
Scheduled Tasks page. This can help administrators identify runs that are
having problems.

Notifications are available for the IBM EMM Scheduler

Administrators and users who create schedules can now set up notifications, to
monitor the status of scheduled runs. Notifications can be sent to the user's email
or system in box.

Users with Administrator permissions in Marketing Platform can set up groups of
users to whom schedule notifications are sent.

Support for clustering has been added

Marketing Platform, including the IBM EMM Scheduler, now supports clustering.

A new configuration property, Platform | Is this deployment clustered, has been
added as part of this support. This property must be set to True for a clustered
environment.

In this release, when Marketing Platform is installed in a clustered environment,
eMessage is not supported.

In this release, clustering is supported only when Marketing Platform is deployed
on WebSphere. (RTC8834)

The configTool utility has a new option for manual upgrades

A new -vp command in the configTool utility has been introduced. It is used
mainly in manual upgrades, to import configuration properties. If you applied a
fix pack that contains a new configuration property, and you then upgrade,
importing a configuration file as part of a manual upgrade process can override
values that were set when the fix pack was applied. The -vp command ensures
that the import does not override previously set configuration values.

When you use -d with the -vp command, the configTool deletes any child nodes in
the path you specify if those nodes are not included in the XML file you specify.

See the IBM Marketing Platform Administrator's Guide for complete details on the
configTool utility.

Sorting performance has improved for alerts, notification, and
scheduler pages

Server side sorting has been implemented for the column sort feature to improve
performance on the alerts, notification, and scheduler pages. This is especially
noticeable when you use the column sort feature on a large number of records.
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Single sign-on is enabled with IBM SPSS® Modeler Advantage
Enterprise Marketing Management Edition

If your organization uses IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition, you can enable single sign-on with IBM EMM. Single sign-on
allows users to navigate to IBM SPSS Modeler Advantage Marketing Edition from
within the IBM EMM user interface without being prompted to log in.

See the IBM Marketing Platform Administrator's Guide for instructions on configuring
single sign-on.

IBM EMM installation and upgrade improvements

The improvements to the installation and upgrade process include:
v Installation guides for all products have been rewritten and reorganized into

separate installation and upgrade guides, to make information easier to find and
use.

v The installers have been enhanced to include better descriptions of the
information you need to enter and to clarify what steps to take during each
stage of the installation.

v Each installer now provides links directly to the product's installation and
upgrade guides, in either PDF or HTML formats.

Browser behavior in IBM EMM products
IBM EMM products have certain browser restrictions and requirements.

Supported browsers

For a list of supported browsers, see the IBM Enterprise Marketing Management
Recommended Software Environments and Minimum System Requirements for version
9.1.0.

Pop-up blockers

You must disable any pop-up blockers in your browser or browser add-ons, such
as toolbars. Pop-up blockers prevent the flowchart window from opening.

Navigation methods

Do not use the browser controls to navigate. For example, avoid using the
browser's Back and Forward buttons. Instead, use the controls supplied in the IBM
EMM user interface.

Using multiple browser windows in Internet Explorer

This restriction applies to using Internet Explorer (IE) with IBM Campaign or any
module that uses Campaign flowcharts (eMessage, Contact Optimization, Interact,
Distributed Marketing).

To log in multiple times to view side-by-side information, you must open IE and
log in to IBM EMM. Then select File > New Session in the IE menu bar. In the
new IE browser window, log in to IBM EMM as the same or a different user.

Important: Do not use any other method to open multiple sessions. For example,
do not open a new tab; do not open another browser session from the Start menu
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or desktop icon; and do not use File > New Window in IE. These methods can
corrupt information that is shown in the application.

For details, see the IBM Campaign User's Guide.

New features and changes in version 9.0.0
This section describes the new features and changes introduced in the 9.0.0 version
of Marketing Platform.

The name of the application has changed

Unica Marketing Platform is now known as IBM Marketing Platform. References to
“Unica” have been removed from the product.

Russian translation is now available

The Marketing Platform user interface and documentation is now available in
Russian as well as in the previously available languages.

Alerts and notifications are enhanced

The existing notification feature has been enhanced as follows. The toolbar now
displays the number of notifications waiting for a user, and users can now manage
their notifications from the toolbar. Distributed Marketing and Marketing
Operations currently send notifications.

Alerts are a new feature. Alerts are presented in a pop-up window when users log
in. At the time of the 9.0.0 release of Marketing Platform, no products are using the
alerts feature, but it is available for adoption by IBM EMM products.

Administrators can also configure Marketing Platform to send email versions of
notifications and alerts.

Dashboards are enhanced

The following enhancements are implemented for dashboards.
v Quick links are a new feature. Quick Links are pre-defined links to IBM EMM

products. Some quick links enable users to perform basic actions in the IBM
EMM product within the dashboard, without navigating to the product.
Administrators can configure portlets that contain a set of quick links that they
choose. The same security considerations apply for quick links as for pre-defined
portlets.
As of the 9.0.0 release, only Marketing Operations provides quick links.

v Pre-assembled dashboards are a new feature. Pre-assembled dashboards include
portlets appropriate for various audiences. Pre-assembled dashboards are
available as soon as Marketing Platform is installed. However, to fully
implement these dashboards you must also install any products required to
support the portlets they include.

v Dashboards now support Flash-based IBM Digital Analytics reports.
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Fixed defects
This section describes the fixed defects in the 9.1.0 version of Marketing Platform.

RTC9846 The installer allowed unsupported in-place upgrade. Although direct,
in-place upgrade from version 7.5.x to version 9.1.0 is not supported,
the installer performed the installation to the same directory where the
earlier version was installed without giving any error messages or
confirmation prompts. This has been fixed.

RTC10141 Links to recently viewed pages in Campaign sometimes did not work.
This occurred most often when Campaign was localized to a multi-byte
language. This has been fixed.

RTC8341 Users were unable to log in; the application froze due to deadlocks.
This has been fixed.

RTC8236 Memory leaks required that the application be restarted regularly to
avoid an out of memory error. This has been fixed.

RTC13594 Duplicate user roles were created during upgrade when the populateDB
utility was executed for Marketing Platform. This has been fixed.

RTC6697 When you sorted a column on the Scheduled Runs page, and if the list
was long enough to require multiple pages, the sort order was not
retained when you navigated to another page in the list. This has been
fixed.

Known issues
This section describes the known issues in the 9.1.0 version of Marketing Platform.

When you install
the report
component, the
Marketing
Platform installer
is sometimes
unable to create
some required
directories on the
Cognos machine

RTC72226 The account used to run the installer should have
permissions to write in the following folders under the
Cognos installation.

v configuration

v webapps\p2pd\WEB-INF\AAA\lib

v templates\ps

v webcontent\schemas

v bin

If the installtion was run with an account that does not
have these permissions, after installation, you can log in
to the Cognos machine with an account that does have
the required permissions, and then run the
copyCognosFiles.bat script, which is located in the
tools\cognos10 directory under the Marketing Platform
installation.

Schedule fails
when non-ASCII
characters are
used in scheduled
objects

RTC72022,
DEF063677

If you configure a scheduled run for a Campaign
flowchart or other object that was created using
non-ASCII characters (such as Chinese), the schedule
fails.
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In a clustered
environment,
manual LDAP
synchronization
fails if the active
node goes down

RTC23676 In a clustered installation, if you synchronize LDAP
users manually, one of the nodes in the cluster connects
with the LDAP server to perform the synchronization. If
the node that is performing the synchronization goes
down before the synchronization is completed, an error
occurs, and you cannot restart the manual
synchronization until the process times out. The default
value for this timeout is set to 600 minutes in the
Platform | Security | Login method details | LDAP
synchronization | LDAP sync timeout configuration
property. You can set this value to a lower number.

Location of
installer logs is
incorrectly
displayed for AIX

RTC7408 The location of the installer logs stdout and stderr is
incorrectly displayed in the installer wizards when the
home directory of user is set to /, which is the case for
the root user on AIX. It is not a requirement to run the
IBM EMM installers as root. If you do run the installers
as root on an AIX system, you can find the logs in the //
directory.

Marketing
Platform upgrade
from 8.5 to 9.1
completes with
errors in the
installation log

RTC103371 The upgrade from Marketing Platform version 8.5 to
version 9.1.0 may complete with the following message
in the installer log.

The DELETE statement conflicted with the REFERENCE
constraint "FK_USM_RPM_ROLE". The conflict occurred
in database database_name, table
"dbo.USM_ROLE_PERMISSION_MAP", column ’ROLE_ID’.

If this error occurs after you have run the installers as
described in the Marketing Platform 9.1.0 Installation
Guide, perform the following step to resolve the issue.

Run the following SQL statement against your Marketing
Platform system table database.

DELETE FROM USM_ROLE_PERMISSION_MAP

WHERE ROLE_ID IN (SELECT ID from USM_ROLE

WHERE APPLICATION=(SELECT APP_ID from
USM_APPLICATION WHERE APP_ID=106));

DELETE FROM USM_ROLE WHERE APPLICATION = 106;

Chinese (Taiwan)
locale is removed

RTC107066 In previous versions of Marketing Platform, Chinese
(Taiwan) was one of the locale options available. This is
not a supported locale, and it has been removed from the
9.1.0 version of Marketing Platform. If a user was
assigned this locale, an administrator must assign a new
locale to that user.

Text in the Detail
column on the
Scheduled Runs
page is not
translated

RTC73856 On the Scheduled Runs page, the content in the Details
column is not translated.

When you use the
browser's Back
button to navigate
in IBM EMM
products, the UI
can be distorted

RTC75262 You should use links within the products to navigate in
IBM EMM products, rather than the browser's Back
button.
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When you
perform an
operation that
requires a page
refresh on the
IBM EMM
Scheduler
management
pages after the
session times out,
an error occurs

RTC66262 When you perform an operation that requires a page
refresh on the Schedule Definitions or the Scheduled
Runs page, an error occurs if the session has timed out.
Examples of this type of operation include clicking the
Refresh button, sorting a column, and clicking a
pagination link. If this occurs, log out of IBM EMM and
then log in again.

Users can not log
out from
Campaign or
Marketing
Platform pages

RTC121489 When Campaign is installed with any other IBM EMM
products, you can not log out from Campaign or
Marketing Platform pages. The work around is to go to
any product page other than Campaign or Marketing
Platform pages, and log out from there.

Known limitations
This section describes the known limitations in the 9.1.0 version of Marketing
Platform.

Reports folder
permissions are
synchronized
across
partitions

DEF045222 In a multi-partition environment, if you synchronize
reports folder permissions in one partition, the folder
permissions for other partitions are also added to that
partition. The synchronization of folders that do not
belong to the current partition does not cause any
authorization problems.

Some
Campaign
configuration
properties are
incorrect after
upgrade

DEF045746 After you upgrade Campaign from version 7.x to 8.1.0,
some configuration properties are incorrect.

v "Affinium" appears in some property display names.
This naming inconsistency does not affect
functionality.

v Under the Campaign category, the unicaUdiSvr
category and its properties appear, although they are
not used in Campaign 8.1.0.

You can use the configTool utility to remove "Affinium"
from display names or remove the unicaUdiSvr category.
Here is an example of how you would do this

v Open a command window in the tools/bin directory
under your Marketing Platform installation.

v Use configTool to export all the Campaign properties
to a file. The following example command exports the
properties to a file named campaignProperties.xml in
the tools/bin directory.

configTool -x -p "Affinium|Campaign" -f
campaignProperties.xml

v Edit the exported file in a text or XML editor.

v Use configTool to import the revised file, using the
overwrite option. For example:

configTool -i -p "Affinium" -f
campaignProperties.xml -o
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Partition
memberships
are lost during
7.2.x to 7.5.x
upgrade

DEF046155,
DEF046162

If your version of Affinium Manager is earlier than 7.5.x,
you must upgrade to 7.5.1 before you upgrade to
Marketing Platform version 8.x. The upgrade scripts for
Affinium Manager 7.5.1 do not automatically preserve
partition membership. Instead, you must manually
restore partition membership before you upgrade to
Marketing Platform 8.x. This process is described in the
Marketing Platform Installation Guide.

Active
Directory users
cannot log in
to NetInsight
or Customer
Insight

DEF046778 When Marketing Platform is integrated with Active
Directory, a user synchronized from Active Directory or
an LDAP server cannot log in to Digital Analytics for On
Premises or CustomerInsight.

Uninstalling an
IBM EMM
application
does not
remove its
menu items

DEF047048 If you uninstall an IBM EMM application, the menu
items for that application remain on the Configuration
page. You can remove them by going to the
Configuration page, locating the appropriate menu
settings under the Platform | Platform-wide navigation
category, and clicking Delete category.

Deleting an
LDAP group
mapping does
not remove
users from the
mapped group

DEF047290 When you delete an LDAP group mapping on the
Configuration page, users that were imported into the
mapped group are not removed from that group. You
should remove the users from the group manually.

An error
occurs when
you cancel a
report run

DEF047550 When you cancel a running report and then try to run
another report, an error message is displayed. You
should select the Analytics menu and run the report
again.

Uninformative
error message
appears when
you enter a
role name that
exceeds length
limit

DEF047639 When you enter a role name longer than 120 characters
(the length limit), the error that appears reads "Error
500--Internal Server Error." The message should indicate
the length limit.

Logout link is
redundant with
Windows
integrated
login

DEF047870 When Marketing Platform is integrated with Windows
Active Directory and Windows integrated login is
enabled, you can not log out using the Log Out link.
When you click Log Out, your browser session ends and
it appears that you are logged out of IBM EMM, but
then you are automatically logged in again. You should
close your browser when you log out of IBM EMM.

When you use
Edit
Preferences to
set a Start
page, you
cannot use an
IBM EMM
URL

DEF050523 If you set a Start page for a user using the Edit
Preferences page for that user, you should not use the
initial IBM EMM login URL (http://host:port/unica ),
or you will encounter problems.

Non-ASCII
characters not
allowed in
throttling
group names

DEF050689 When you create a throttling group for the scheduler, an
error message appears if you use non-ASCII characters.
Use only ASCII characters in throttling group names.
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Errors occur
during
upgrade from
7.5.x to 8.x

DEF050735 When you upgrade from Affinium Manager 7.5.x to
Marketing Platform 8.x, the data source keys stored in
your existing Manager system tables must be
un-encrypted and then re-encrypted to be stored in the
database for 8.x.

If you have changed your keystore password in 7.5.x
using (encryptPasswords -k), and if Platform is not
installed on AIX®, you can use the following procedure
to correct the problem.

Note that this workaround does not apply when the
Platform is installed on AIX. In that case, you must log
in to IBM EMM and change data source passwords
manually.

This procedure ensures that you have the latest Java™

Cryptography Extension (JCE) Unlimited Strength
Jurisdiction Policy Files 5.0.

Download these files here: http://java.sun.com/javase/
downloads/index_jdk5.jsp

Scroll to Java Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files 5.0 and do the
following.

1. Ensure that the JRE in your Manager 7.5.x installation
has the updated JCE Unlimited Strength Jurisdiction
files. Follow instructions in the download to copy the
local_policy.jar and US_export_policy.jar to the
jre/lib/security directory.

2. Use encryptPasswords -k to encrypt your keystore
password again.

3. If you are NOT using the JRE provided in the
Platform installer, also update the JCE Unlimited
Strength Jurisdiction files for the JRE you intend to
use.

4. Run the Platform installer and your keys will be
migrated to 8.x.

If the JCE updates are not made, or if you were unable
to use the workaround because your Platform system
table database is AIX, you may see these errors:

Cannot retrieve the key from the file
[<INSTALL_DIR>\Affinium\Manager\conf\kfile], cause:
Illegal key size

javax.crypto.BadPaddingException: pad block corrupted

If these errors occur, log in to IBM EMM and change
data source passwords manually.

User names
cannot contain
spaces or
punctuation
characters

DEF051877 If a user's login name contains a space or punctuation
character, a JavaScript error appears on every page,
although the user can navigate and use IBM EMM
normally. Do not include spaces or punctuation
characters in login names of user accounts.
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Non-ASCII
characters are
not supported
for group, role,
and policy
names

DEF051431 If you attempt to use non-ASCII characters in group,
role, or policy name, you see the following error
message: Please use only alphanumeric characters. You
should not use non-ASCII characters in these names.

Duplicate role
names are not
allowed

DEF051895 In Affinium Manager 7.5.x, duplicate role names were
allowed. Starting with Marketing Platform 8.0.0,
duplicate role names are not allowed. If you upgrade
from 7.x to 8.x, and you have multiple roles with the
same name, you should rename roles so that no
duplicates exist before you upgrade.

Installer
message for
directory to
upgrade
Platform 7.5.x
is confusing

DEF051952 When you upgrade Marketing Platform 7.5.x to 8.1.0, the
installer prompts you to specify the directory where the
7.5.x version is installed. If the installer cannot find the
installation registry in that directory, it displays the
following message: Manager Upgrade directory
specified [directory] was not found by the
installer. If you see this message during upgrade, you
should verify that the specified directory is the correct
one, and then proceed with the upgrade.

Issues related to third-party software
This section describes the issues in the 9.1.0 version of Marketing Platform that are
related to third-party software.

Generating
materialized
view SQL fails
on some Oracle
versions

DEF041909 Using the reporting SQL generator to create a
materialized view fails when the Marketing Platform
system table database is certain version of Oracle. This is
due to Oracle defect 6485782. The issue is fixed in Oracle
version 11.1.0.7 (Server Patch Set).
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user’s user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer’s
website terms of use (e.g. privacy policy) which includes a link to IBM’s and
Client’s data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor’s computer by IBM on the Client’s behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client’s behalf on
website visitor’s devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM’s Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled “Cookies, Web Beacons and Other
Technologies."
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.

© Copyright IBM Corp. 1996, 2013 15
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